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Copyrights
Copyright © 2005 LaCie. All rights re-
served. No part of this publication may 
be reproduced, stored in a retrieval sys-
tem, or transmitted in any form or by 
any means, electronic, mechanical, pho-
tocopying, recording or otherwise, with-
out the prior written consent of LaCie.

Trademarks
Apple, Mac, Macintosh and FireWire 
are registered trademarks of Apple 
Computer, Inc. Microsoft, Windows 
NT, Windows 98, Windows 98 SE, 
Windows 2000, Windows Millennium 
Edition and Windows XP are registered 
trademarks of Microsoft Corporation. 
Sony and iLink are registered trade-
marks of Sony Electronics. Other trade-
marks mentioned in this manual are the 
property of their respective owners.

Changes
The material in this document is for in-
formation only and subject to change 
without notice. While reasonable ef-
forts have been made in the preparation 
of this document to assure its accuracy, 
LaCie assumes no liability resulting 
from errors or omissions in this docu-
ment, or from the use of the informa-
tion contained herein. LaCie reserves 
the right to make changes or revisions 
in the product design or the product 
manual without reservation and without 
obligation to notify any person of such 
revisions and changes.

FCC Statement
This device complies with Part 15 of the 
FCC Rules. Operation is subject to the 
following conditions: 
1. The devices may not cause harmful 
interference
2. The devices must accept any interfer-
ence received, including interference 
that may cause undesired operation
NOTE: This equipment has been tested 
and found to comply with the limits for 
a Class B digital device, pursuant to Part 
15 of the FCC Rules. These limits are 
designed to provide reasonable protec-
tion against harmful interference in a 
residential installation. This equipment 
generates, uses and can radiate radio 
frequency energy and, if not installed 
and used in accordance with the instruc-
tions, may cause harmful interference to 
radio communications. However, there 
is no guarantee that interference will 
not occur in a particular installation. If 
this equipment does cause harmful in-
terference to radio or television recep-
tion, which can be determined by turn-
ing the equipment off and on, the user is 
encouraged to try and correct the inter-
ference by one or more of the following 
measures:

Reorient or relocate the receiving an-
tenna.

Increase the separation between the 
equipment and receiver.

Connect the equipment into an out-

•

•

•

let on a circuit different from that to 
which the receiver is connected.

Consult the dealer or an experienced 
radio/TV technician for help.

Modifications to this product not 
authorized by LaCie could void the 
FCC & Industry Canada regulations 
and negate your authority to operate the 
product. 

Canada Compliance Statement
This Class B digital apparatus com-

plies with Canadian ICES-003.

Manufacturer’s Declaration 
for CE Certification
We, LaCie, solemnly declare 

that this product conforms to the fol-
lowing European standards:

Class B EN60950-1:2003, EN55022: 
1998, EN55024:1998 +A1, EN61000-
3-2: 2000, EN61000-3-3:2001

With reference to the following 
conditions:

73/23/EEC Low Voltage Directive

89/336/EEC EMC Directive

This symbol on the product 
or on its packaging indi-
cates that this product must 
not be disposed of with 

your other household waste. Instead, it 
is your responsibility to dispose of your 
waste equipment by handing it over to 
a collection point for the recycling of 
electrical and electronic equipment.  The 
collection and recycling of your waste 
equipment at the time of disposal will 
help to conserve resources and ensure 

•

Forward

Tested To Comply 
With FCC standards
FOR HOME OR
OFFICE USE

LaCie Biggest S2S
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that it is recycled in a way that pro-
tects health and the environment. For 
information about where you can drop 
off your equipment for recycling, please 
contact your city waste disposal service.

CAUTION: Modifications not 
authorized by the manufacturer 
may void the user’s authority to 
operate this device.

CAUTION: A shielded-type 
power cord is required in order to 
meet FCC emission limits and also 
to prevent interference to the near-
by radio and television reception. It 
is essential that only the supplied 
power cord be used.

Do not expose the LaCie Biggest S2S 
to temperatures outside the range of 
0° C to 35° C (32° F to 95° F); or to 
operational humidity beyond 5-80%, 
non-condensing, or non-operating 
humidity beyond 10-90%, non-con-
densing. Doing so may damage the 
LaCie Biggest S2S or disfigure its 
casing. Avoid placing your LaCie 
Biggest S2S near a source of heat or 
exposing it to sunlight (even through 
a window). Inversely, placing your 
LaCie Biggest S2S in an environ-
ment that is too cold or humid may 

• damage the unit.

Rated cooling for altitudes up to 
2000 meters.

Always unplug the LaCie Biggest 
S2S from the electrical outlet if there 
is a risk of lightning or if it will be 
unused for an extended period of 
time. Otherwise, there is an increased 
risk of electrical shock, short-circuit-
ing or fire.

Use only the power supply shipped 
with the device.

•

•

•

Do not use the LaCie Biggest S2S 
near other electrical appliances such 
as televisions, radios or speakers. Do-
ing so may cause interference which 
will adversely affect the operation of 
the other products.

Do not place the LaCie Biggest S2S 
near sources of magnetic interference, 
such as computer displays, televisions 
or speakers. Magnetic interference 
can affect the operation and stability 
of your LaCie Biggest S2S.

Do not place heavy objects on top of 

•

•

•

Health and Safety Precautions

Only qualified persons are authorized to 
carry out maintenance on this device.

• Read this User’s Guide carefully, and 
follow the correct procedure when set-
ting up the device.

• Do not open your LaCie Biggest S2S 
or attempt to disassemble or modify it. 
Never insert any metallic object into the 
drive to avoid any risk of electrical shock, 
fire, short-circuiting or dangerous emis-
sions. Your LaCie Biggest S2S contains 

no user-serviceable parts. If it appears 
to be malfunctioning, have it inspected 
by a qualified LaCie Technical Support 
representative.

• Never expose your device to rain, or 
use it near water, or in damp or wet con-
ditions. Never place objects containing 
liquids on the LaCie Biggest S2S, as 
they may spill into its openings. Doing 
so increases the risk of electrical shock, 
short-circuiting, fire or personal injury.

• Make sure that the computer and La-
Cie Biggest S2S are electrically ground-
ed. If the devices are not grounded, there 
is an increased risk of electrical shock.
Power requirements 100-240 V~, 4-2 
A, 60-50 Hz, (Supply voltage fluctua-
tions not exceeding ± 10% of the nomi-
nal, transient over-voltages according to 
over-voltage category II).

General Use Precautions
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the LaCie Biggest S2S or use exces-
sive force on it.

Never use excessive force on your 
LaCie Biggest S2S. If you detect a 
problem, consult the Troubleshoot-
ing section in this manual.

Protect your LaCie Biggest S2S 
from excessive exposure to dust dur-
ing use or storage. Dust can build up 

•

•

inside the device, increasing the risk 
of damage or malfunction.

Never use benzene, paint thinners, 
detergent or other chemical products 
to clean the outside of the LaCie Big-
gest S2S. Such products will disfigure 
and discolor the casing. Instead, use a 
soft, dry cloth to wipe the device.

Do not attempt to remove a hard 

•

•

disk from a Drive Bay. Removal of 
a hard disk by anyone other than an 
authorized LaCie Technical Support 
representative will void the warranty.

CAUTION: Modifications not 
authorized by the manufacturer 
may void the user’s authority to 
operate this device.

Important Info: Any loss, corruption or destruction of data while using a LaCie drive is the sole responsibility of the 
user, and under no circumstances will LaCie be held liable for the recovery or restoration of this data. To help prevent the loss 
of your data, LaCie highly recommends that you keep TWO copies of your data; one copy on your external hard drive, for 
instance, and a second copy either on your internal hard drive, another external hard drive or some other form of removable 
storage media, such as CD, DVD or Tape. LaCie offers a complete line of CD, DVD and Tape drives, and if you would like 
more information on backup, please refer to the LaCie white paper on backup methods and technology.
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1. Introduction

Congratulations on the purchase of your new LaCie 
Biggest S2S! This high-performance, extremely flexible 
RAID (Redundant Array of Independent/Inexpensive 
Disks) subsystem is ideally suited for integration with 
databases, imaging systems and e-mail and Web serv-
ers. 

RAID technology is one of the best means to pro-
tect your data, while providing greater  data integrity 
and availability than standard hard disk storage.

With the ability to provide single error detection and 
redundant information to recover the original if a disk 
fails, a RAID system is an ideal means to safe-guard 
valuable data while also stream-lining performance.  

The LaCie Biggest S2S is the ultimate approach to a 
flexible RAID solution, with its ability to manage vari-
ous RAID levels (0, 1, 0+1, and JBOD).

1.1. LaCie Biggest S2S Capabilities

Supports powerful RAID 0, 1, 0+1, and JBOD

The newest in Serial ATA (SATA) technology

Easy installation on PC or Mac

•

•

•
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2. Your Biggest S2S

2.1. Minimum System Requirements

Hardware

Windows Mac

An Intel PIII 500MHz equivalent or faster

CD-ROM drive

64 MB of RAM minimum

250 MB of free hard disk space

Super VGA (800 x 600) or higher resolution with 256 
colors

Mouse or compatible pointing device

External SATA cable connection between the LaCie 
Biggest S2S

LaCie SATA II 3Gb/s PCI-X Card 4E or PCI-Ex-
press Card (included)

•

•

•

•

•

•

•

•

A Mac G4 500MHz or faster

CD-ROM drive

64 MB of RAM minimum

250 MB of free hard disk space

Super VGA (800 x 600) or higher resolution with 256 
colors

Mouse or compatible pointing device 

External SATA cable connection between the LaCie 
Biggest S2S

LaCie SATA II 3Gb/s PCI-X Card 4E or PCI-Ex-
press Card (included)

•

•

•

•

•

•

•

•

Software

Windows Mac

Microsoft Windows 2000, Windows XP, or Win-
dows Server 2003 OS with the latest Service Pack 
installed

LaCie Biggest S2S utilities CD (included)

LaCie SATA II 3Gb/s PCI-X Card 4E or PCI-Ex-
press Card CD (included)

•

•

•

Mac OS 10.3.9 with the latest set of patches in-
stalled

LaCie Biggest S2S utilities CD (included)

LaCie SATA II 3Gb/s PCI-X Card 4E or PCI-Ex-
press Card CD (included)

•

•

•
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2.2. Package Content

Important Info: Please save your packaging.  In the event that the product should need to be repaired or 
serviced, it must be returned in its original packaging.  In the event that an individual disk should need to be re-
paired or serviced, please refer to section 5.1. Removing/Replacing A Drive.

LaCie Biggest S2S RAID system tower and 
5 Drive Bays with hard disks

Accessories Box Content

SATA 3Gb/s external cable (2 meters)

LaCie Biggest S2S Utilities CD-ROM 
(includes User’s Manual, Quick Install Guide, 
Storage Manager and Firmware)

LaCie Biggest S2S Quick Install Guide 
(printed version)

Power cable

PCI-X or PCI-Express Card Box Content

LaCie SATA II 3Gb/s PCI-X Card 4E or 
PCI-Express Card

PC Card CD-ROM with User Manual, 
Quick Install Guide and Drivers

PCI Card Quick Install Guide (printed ver-
sion)

1

3

5

2

4

6

Your LaCie Biggest S2S should contain the following:

1 2

User’s Manual       Biggest S2S 
 Utilities

3

LaCie Biggest S2S
Quick Install Guide

4

6

7

8

LaCie SATA II 3Gb/s PCI-X Card 4E
Quick Install Guide

5

User’s ManualSATA II 3Gb/s 
PCI-X Card 4E

7 8
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2.3. Views of the Drive

2.3.1. Front View

Drive Bays – Each drive bay can hold one-inch 
high, 3.5-inch form factor Parallel ATA/IDE 
disk drive.

Disk Status Indicator – Next to each drive,  
blue LED = disk not recognized, green LED = 
disk recognized

Disk Activity Indicator – Blinking green LED

Host LED indicator – Indicates connection 
with the host

! LED – Indicates an error 

OK LED – Indicates no problems found

1

2

3

4

5

6

1

2

3

4

5

6
Technical note: For more information 
about these LEDs, see Chapter 8, LaCie Biggest 
S2S Front Panel LED indicators.
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2.3.2. Rear View

External SATA II 3Gb/s Port

Power Switch

Power Supply Connector

Power Supply Fan 

Casing Fan

1

2

3

4

5

1

23

4

5

CAUTION: To avoid overheating, the LaCie Big-
gest S2S should be installed in a well-ventilated area 
and in such a way as to maintain sufficient airflow 
across the controller chips. Also ensure that the 
Ventilation Fan is not obstructed. 

Environmental Requirements:

Temperature: 0 – 35° C (32 – 95° F)

Operation Humidity: 20 – 80%, non-condensing

Storage Humidity: 10 – 90%, non-condensing
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2.4. Cables and Connectors

2.4.1. Serial ATA II and eSATA

Your LaCie Biggest S2S uses the latest in SATA 
technology, featuring transfer rates of up to 3Gb/s. The 
Biggest S2S comes equipped with eSATA ports and re-
quires the use of an external SATA cable, (included). 
SATA technology was originally developed to serve as 
an internal interface, delivering improved performance 
to internal connections. Soon after, eSATA, or external 
SATA was developed, allowing for the use of shielded 
cables outside the PC. 

eSATA technology was developed to be rugged and 
durable. eSATA connectors do not have the  “L” shaped 
design of other SATA connectors. In addition, the guide 
features are vertically offset and reduced in size to pre-
vent the use of unshielded internal cables in external ap-
plications.

Technical note: The Biggest S2S will 
only work with a LaCie SATA Card, which uses 
an eSATA cable.

Technical note: Performance can vary 
from one Mac or PC to another; performance 
also varies depending on the port used:  PCI-X or 
PCI-Express.

eSATA Cables and Connectors

These are the cables and connectors used to at-
tach Serial ATA drives to your computer.

Serial ATA Port

Serial ATA Cable
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3. Setting Up Your LaCie Biggest S2S

This chapter covers the installation and configuration 
of your LaCie Biggest S2S. A relatively easy process, you 
will be guided through the five following steps:

Step 1 3.1. Storage Policies - Terms to know before you configure the Storage Appliance. The terms 
represent LaCie Biggest S2S configuration options.

Page 14

Step 2 3.2. Installation Prerequisites – What you need to install the LaCie Biggest S2S. Page 16

Step 3 3.3. Installing the PCI-X/PCI-Express Card and Driver –  In order to run the LaCie Biggest 
S2S Manager, you must first install the LaCie SATA II 3Gb/s PCI 4E Card or PCI-Express 
Card and its associated driver. This setup allows a software and hardware link between the 
PC and the LaCie Biggest S2S.

Page 16

Step 4 3.4. Set up the LaCie Biggest S2S disk drives – The Lacie Biggest S2S box houses five con-
figurable disk drives.

Page 17

Step 5 3.5. Install the LaCie Biggest S2S Manager – The LaCie Biggest S2S Manager utility pro-
gram configures and monitors the LaCie Biggest S2S Storage Appliance. 

Page 17
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3.1. Storage Policies

Before you use the LaCie Biggest S2S Manager to 
configure the Storage Appliance, take a minute to study 
the following terms. The terms represent The LaCie 
Biggest S2S configuration options or storage policies for 

mapping the physical to the virtual drives. You’ll choose 
from these policies during the configuration process. 
Your choice is important and impacts how best you can 
use the Storage Appliance.

JBOD A storage policy that grants the host PC direct access to a physical disk drive. With JBOD (just a bunch 
of disks), the number of available drives is equal to the number of physical drives. JBOD is also called the 
bypass mode as the host bypasses the LaCie virtualization engine to directly access the disk. 

Safe A storage policy configuration in which all data is stored in duplicate on separate disks to protect against 
data loss due to disk failure. At least two drives mirror each other at all times, equivalent to RAID 1. Each 
write goes to both disks. Safe provides the highest level of data protection but halves the amount of stor-
age space since all data must be stored twice. To implement the Safe storage policy, the Basic Configura-
tion Mode creates two volumes. Each volume consists of two hard disk drives that mirror each other. The 
remaining hard disk drive is specified as a Hot Spare for both volumes.

Fast A storage policy configuration in which I/O processing is balanced evenly to all disks in a method known 
as striping, equivalent to RAID 0. Fast offers the best performance in terms of speed but no redundancy 
of data. Striping increases storage operation speed by using several disk drives in parallel. Each portion of 
data is divided into segments which are written to different disks simultaneously. Striping provides im-
proved performance but does not enhance reliability because there is no way to retrieve or reconstruct data 
stored on a failed drive. Please check the LaCie website for updates of the User’s Manual reflecting product 
updates.

Big A storage policy configuration in which multiple physical drives are strung together (concatenated) and 
treated as one large volume. Big provides the maximum amount of storage space but no additional perfor-
mance or data redundancy. This configuration allows you to increase logical volume size beyond the capacity 
of individual drives. The Basic Configuration Mode implements the Big storage policy by concatenating all 
the hard disk drives into a single volume.

Safe+Big A storage policy configuration in which one-half of the available storage space is concatenated. The other 
half mirrors the first half to provide full data redundancy. The Safe + Big storage policy configuration mir-
rors the concatenated disks to create a volume consisting of four disk drives. The Basic Configuration Mode 
designates the remaining hard disk drive as a Hot Spare.

Safe+Fast A volume configuration in which an array of stripes is created. Each stripe consists of two mirrored drives. 
Safe + Fast provides the I/O load balancing features of striping and the added reliability of mirrored data, 
equivalent to RAID 1+0. 	 In the Safe + Fast storage policy, data is written to mirrored disks in a striped 
format to create a volume consisting of four disk drives. The Basic Configuration Mode designates the 
remaining hard disk drive as the Hot Spare.
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Hot Spare One or more disk drives are unused during normal operation and are configured to be a spare. If an active 
drive in a Safe volume fails, the data on the remaining disk is duplicated on to the Hot Spare to regain 
redundancy. All Safe volumes can have a designated Hot Spare (Safe, Safe+Fast, and Safe+Big).

Volume A virtual or logical disk comprised of one or more physical disks. Once you create a volume, the operating 
system uses and maintains the volume as if it were a single physical disk. This allows software to overcome 
restrictions imposed by physical disk drives.

Daemon Component of the Biggest S2S Manager responsible for status tracking and Safe volume rebuilds. See 
4.4.5. Manage Client Connection to the Daemon, for further details regarding the daemon.

Setting Up Your Biggest S2S

Important Info: Your LaCie Biggest 
S2S comes preconfigured in Fast mode, similar to 
RAID 0. For more information about RAID lev-
els, see chapter 9, Understanding RAID and Big-
gest S2S Storage Policies.

Important Info: The disks shipped with 
the LaCie Biggest S2S are formatted HFS+. To 
use the drives with Windows operating systems or 
for cross-platform use between Mac and PC, the 
drives must be reformatted. For more information, 
see section 8.2. File System Formats.

Important Info: The Advanced Con-
figuration Mode extends the allowable number of 
volumes created to five drives. The perfomance in 
this case is equivelent to that of a four drive vol-
ume. Also, refer to the note on the following page 
concerning the partition limitation for Windows 
users.
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Refer to your LaCie SATA Card Quick Install 
Guide included on your LaCie SATA II Card CD for 
information on card installation.

Please be sure to check the LaCie website for up-
dated software and manuals at www.lacie.com

In order to run the LaCie Biggest S2S Manager, you 
must first install the LaCie SATA II Card and its asso-
ciated driver. This setup allows a software and hardware 
link between the PC and the LaCie Biggest S2S. 

3.2. Installation Prerequisites

Mac G4 500MHz or faster with Mac OS X with 
latest set of patches installed

PC with Microsoft Windows 2000, Windows XP, or 
Windows Server 2003 OS with latest service pack 
installed

64MB RAM, 250MB free hard disk space

External SATA cable connection between the LaCie 
Biggest S2S Storage Appliance and the PC

The LaCie Biggest S2S Installation CD

•

•

•

•

•

3.3. Installing the PCI-X/PCI-Express Card and Drive
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Setting Up Your Biggest S2S

Power down the host PC.

Attach the external Serial ATA cable to the external 
SATA connector on your host computer.  The con-
nector is keyed and can only be installed in one ori-
entation. Connect the other end of the cable to the 
LaCie Biggest S2S.

The LaCie Biggest S2S supports five drives, which 
are delivered inside it. In case of drive failure, do not 
try to replace the drive yourself; your warranty will 
become void. Please contact your vendor.

Plug the AC cable into the LaCie Biggest S2S and 
the proper AC receptacle, and then turn on the La-
Cie Biggest S2S using the switch on the back panel. 

Turn on the host computer and install the Configura-
tion User Interface software from the supplied CD.

1.

2.

3.

4.

5.

 The LaCie Biggest S2S default configuration is in 
RAID 0 mode.  If other configurations are needed, 
see sections 3.1. Storage policies, 4.4. A Look at the 
Configuration Window and Chapter 9, Understand-
ing RAID and Biggest S2S Storage Policies.

The disks shipped with the unit are formatted 
HFS+. 

6.

7.

Important Info: The disks shipped with 
the LaCie Biggest S2S are formatted HFS+. To 
use the drives with Windows operating systems or 
for cross-platform use between Mac and PC, the 
drives must be reformatted. For more information, 
see section 8.2. File System Formats.

3.5. Set Up the Biggest S2S Disk Drives

3.5.1. Windows Users

The LaCie Biggest S2S box houses five configurable 
disk drives.  

Plug the LaCie Biggest S2S into an outlet and flip 
the LaCie Biggest S2S power switch to ON.

Attach the Storage Appliance to the LaCie SATA II 
Card with an external SATA cable. 

 To view the disk drives, right-click on the My Com-
puter icon and then select Manage. 

1.

2.

3.

4.
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4. Click Disk Management under Storage to view the 
disk drives. In case an Initialize and Convert Disk 
Mode dialog appears, click Cancel to abort it and 
proceed to Disk Management. Notice that all five 
drives are visible in their pre-configured and unallo-

cated state. The Status window provides details of the 
volume allocation. A sixth device appears without ca-
pacity in the list to represent the SteelVine processor. 
This device will appear for all Biggest S2S configura-
tions. Do not initialize or partition this drive.

Technical note: Windows recognizes five 
152.50GB hard disk drives for an LaCie Biggest 
S2S in Bypass mode populated with five 160GB 
hard disk drives.
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3.5.2. Mac Users

The Biggest S2S Storage Appliance houses five con-
figurable disk drives. 

Plug the Biggest S2S into an outlet and turn the Big-
gest S2S power switch to ON.

Attach the Storage Appliance to the LaCie SATA II 
Card with an eSATA cable. 

A warning appears. Because the Biggest S2S ships 
with empty drives, Mac OS X does not identify a 
recognizable file system. Click Ignore.

Launch Disk Utility from the Application/Utilities 
folder to view the disk drives.

1.

2.

3.

4.
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5. Notice that all five drives are visible in their pre-con-
figured and unallocated state. “320KB SV Configure” 
drive appears in the list to represent the SteelVine 
processor. Do not initialize or partition the “320KB 
SV Configure” drive.

Technical note: Do not initialize or par-
tition the “320 KB SV Configure” drive.  Mac OS 
X recognizes five 152.7 GB hard disk drives for 
an Biggest S2S in JBOD (bypass mode) populated 
with five 160GB hard disk drives.

Insert the installation CD into your CD-ROM 
drive.

Open the installation CD and select the Windows 
folder as shown.

Double-click on the LaCie Biggest S2S Setup pro-
gram to begin the installation procedure.

1.

2.

3.

3.6. Install the LaCie Biggest S2S Manager

The LaCie Biggest S2S Manager utility program 
configures and monitors the LaCie Biggest S2S Storage 
Appliance. The utility consists of a daemon and a user 
interface installed by the setup program on the LaCie 
Biggest S2S installation CD. 

3.6.1. Windows Users
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4. The InstallShield® Mode start screen will soon ap-
pear.  Click Next to continue.

5. Next, select the location on your computer to install 
the program.  If you do not have a preference, click 
Next to use the default location.

6. Next, select the Program Folder into which the 
shortcuts should be placed. If you do not have a pref-
erence, click Next.
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7. Click Next to begin the installation process.

8. The install program will then copy and setup all files 
required for the LaCie Biggest S2S Manager.  When 
complete, the following screen should appear.

9. The LaCie Biggest S2S Manager is installed in the 
Programs section of the Start menu under S2S Man-
ager, as shown below. The installation creates a short-
cut. The S2S Manager application displays the infor-
mation captured by a daemon, which monitors the 
S2S Storage Appliance. The daemon is installed as a 
service during the installation.

10. The daemon is launched every time Windows is 
started.

Setting Up Your Biggest S2S
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1. Insert the installation CD into your CD-ROM 
drive.

2. Open the installation CD and select the Mac folder 
as shown.

3. Double click the Biggest S2S Setup.pkg file to begin 
the installation procedure.

3.6.2. Mac Users

4. The start screen appears. Click Continue.

5. Review the Read Me file. Click Continue.
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6. Review the License agreement. Click Continue.

7. Click Agree to accept the License agreement.

8. Select the local hard disk drive. Click Continue.

9. Click Install to begin the installation process.

Setting Up Your Biggest S2S
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10. The install copies and sets up files required for the 
Biggest S2S Manager. Click Close to conclude the 
installation.

11. The Biggest S2S Manager is installed in the /Utili-
ties/Biggest S2S directory. The Biggest S2S appli-
cation launches a daemon process to monitor the 
Biggest S2S Storage Appliance. The Biggest S2SUI 
application launches the Biggest S2S Manager to 
display the information captured by the daemon.

The daemon launch script is also added to the /Li-
braries/StartupItems/BiggestS2SDaemon directory to 
launch the daemon every time Mac OS is started. 

Technical note: The daemon has root 
user privileges.

Setting Up Your Biggest S2S
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The LaCie Biggest S2S Manager is installed in the 
Programs section of the Start Menu. 

Select the LaCie Biggest S2S icon to launch the user 
interface. You’ll notice the Status window appear on 
the screen.

1.

Using Your Biggest S2S

4. Using your LaCie Biggest S2S

The LaCie Biggest S2S Manager manages and 
monitors the LaCie Biggest S2S Storage Appliance. 
The Manager primarily consists of the following two 
windows:

Status window
Configuration Mode

•
•

The Status window is the first to appear following 
the launch of the LaCie Biggest S2S Manager. The 
Configuration Mode and all following screens can be 
accessed with a password. For additional information on 
managing passwords see 4.2 Customize password.

4.1. To run the LaCie Biggest S2S Manager 

4.1.1. Windows

2. Use the Status window to monitor the LaCie Biggest 
S2S status. The LaCie Biggest S2S Manager dialogs, 
such as the Configuration Mode, can be accessed after 
entering a password. The default password is admin.

The LaCie Biggest S2S Manager allows you to cus-
tomize your password.  See 4.2. Customize password.
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Before the Biggest S2S Manager launches, the 
launch sequence will search for an active daemon and 
launch a daemon if the daemon is not active. To initi-
ate the daemon, the launch sequence will require that 
you provide the administrator user’s password. The 
Biggest S2S Manager is installed in the Applications-
>Utilities>Biggest S2S folder.

1. Launch the Finder and locate the Biggest S2S pro-
gram within the Applications/Utilities/Biggest S2S 
folder. Click the Biggest S2S icon to launch the S2S 
Manager.

2. Use the Status window to monitor the Biggest S2S 
status. Biggest S2S Manager dialogs, such as the 
Configuration Mode, can be accessed by entering a 
password. The default password is admin.

4.1.2. Mac OS X

4.1.3. Biggest S2S Manager Launch Sequence (Mac OS X)
Before the Biggest S2S Manager launches, the 

launch sequence will search for an active daemon and 
launch a daemon if the daemon is not active. To initiate 
the daemon, the launch sequence will require that you 
provide the administrator user’s password.

1. Launch the Finder and locate the Biggest S2S pro-
gram within the Applications/Utilities/Biggest S2S 
folder. Click the Biggest S2S icon to launch the Big-
gest S2S Manager.
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2. The launch sequence will search for an active daemon. 
If the search fails, a warning appears. Click OK.

3. The Biggest S2S daemon requires administrative 
privileges. Enter the administrator password and 
click OK.

4. A notice appears as the launch sequence attempts to 
start the daemon. Click OK. In case the attempt fails, 
two additional retries occur.

5. Should the daemon fail to start, an error message ap-
pears.

4.2. Customize Password

The LaCie Biggest S2S Manager limits configura-
tion access with a password prompt. The password in-
formation is stored locally on the server running the 
daemon.

The default password is admin.

To change the password

Select Change Password from the File Menu.

Enter the current password (or use admin if you have 
not changed the default password).

Enter the new password within the provided fields.

The entered password must be a combination of 5 or 
more characters.	

Click OK to implement the new password.

1.

2.

3.

4.

5.
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4.3. A look at the LaCie Biggest S2S Status Window

The LaCie Biggest S2S Status window provides a 
systems summary. Take a moment to review the Status 
window. 

System Status

Capacity
Information

Drive Status

For each LaCie Biggest S2S attached to the PC, the 
Status window presents a separate tab. Each connected 
PC is identified by its serial number (S/N #) on the tab. 

Each tab consists of two tables. The upper table 
shows the following system and disk drive status:

Upper Table Column Tabs Upper Table Row Tabs

The Temp column indicates the current temperature of 
the LaCie Biggest S2S Storage Appliance (32º C/90º 
F). See 6. Monitor the LaCie Biggest S2S Storage Ap-
plication for details.

The Fan Speed column indicates the current RPMs for 
the system fan. The Fan Speed value and system tem-
perature can be read to diagnose malfunctions. See 6. 
Monitor the LaCie Biggest S2S Storage Application.

Columns 3-7 identify the five disk drives.

•

•

•

The Box Status row shows the state of each disk drive as 
normal, rebuilding, unplugged, and requiring a rebuild 
or new drive.

The Drive Serial number row is the unique manufac-
turer assigned identifier used to distinguish the hard disk 
drives within the Storage Appliance.

The Expected Serial # row shows the serial number of 
the hard disk drive within the bay during volume con-
figuration. The Status window compares the Expected 
and actual Drive serial numbers to recognize a status 
change.

•

•

•
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The lower table of the Status window notes capacity 
information. The first row of the table shows individual 
hard disk drive capacities. The table contains additional 

rows for each implemented volume to show volume 
capacity and capacity distribution amongst the present 
hard disk drives.

Lower Table Column Tabs Lower Table Row Tabs

The Policy column shows the storage policy used for 
that volume.

The Total column indicates the combined capacity of 
the volume.

The Drive #0, 1,2,3,4 columns provide capacity infor-
mation pertaining to each drive.

•

•

•

The Capacity row shows the full amount of storage 
space (in GB) available on each hard disk drive.

The Volume row(s) show(s) the total capacity of each 
volume and the individual disk capacities assigned to 
each volume. 

•

•

The File and Edit menus of the Status window con-
tains the following items:

File Menu Edit Menu

Change password launches a dialog to establish a new 
password.

Scan Devices refreshes the tabs presented by the Status 
window.

Change connections launch a dialog to make remote 
connections.

•

•

•

Configure Box launches the Configuration Mode.

Specify Policy launches the Rebuild Policy configuration 
dialog.

Event Log presents the event log viewer.

Specify firmware launches the Firmware Selection dia-
log for firmware deployment.

•

•

•

•

The Status window Toolbar consists of these buttons:

Button Function Button Function

This button opens the LaCie Biggest S2S Con-
figuration Mode.

The button opens the Storage Policy Man-
ager. See chapter 3.1. Storage Policies for 
details.

The button opens the Event log viewer. See chap-
ter 10.3. Review Event log for details.

This button opens the Firmware Manager.

This button opens the Email Notification viewer.  
See chapter 4.4.6. Email Notification for details.

Using Your Biggest S2S
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4.4. A look at the LaCie Biggest S2S Configuration Mode

The LaCie Biggest S2S Configuration Mode is ac-
cessible from the Status window and allows volume 
management. The Basic Configuration Wizrd defines 
volumes based on a selected storage policy and does not 
allow volume counts or capacities to be modified. To 
protect against unintended changes, the LaCie Biggest 
S2S Manager prompts for a password the first time the 
Mode is accessed. (see 4.2. Customize password for ad-

ditional information on password management).

The Configuration Mode runs in one of two modes. 
The Basic mode of the Configuration Mode defines vol-
umes based on a selected storage policy and does not 
allow volume counts or capacities to be modified. In 
Advanced mode, the Configuration Mode provides ad-
ditional volume management flexibility.

4.4.1. Basic Configuration Mode

Take a moment to review the LaCie Biggest S2S 
Basic Configuration Mode window.

Basic Configuration Mode Components

The Storage Policy frame on the left consists of six 
radio buttons representing available storage policies.  
See 3.1. Storage Policies.

The volumes table below the Storage Policy frame 
consists of a Volume, Mode, and Size columns to 
summarize the created volumes.

The Total GB’s Left box in the lower left window 
shows the remaining capacity in GB for all the disk 
drives

The remainder of the Configuration Mode graphically 
displays disk space. All space allocated to the same vol-
ume appears in a matching color. The Configuration 
Mode displays a hatch pattern to indicate a proposed 
configuration while a solid block indicates an existing 
volume. 

•

•

•

•
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Button Function

Reads the saved volume configuration. See chapter 4.4.4.1. To import a file for details

Writes the saved volume configuration. See chapter 4.4.4.1. To import a file for details

Cancels proposed changes

The toolbar of the Configuration Mode consists of 
these buttons:

Three buttons at the bottom of the Configuration 
Mode control the affected change(s):

Apply causes the Mode to download the changes to the LaCie Biggest S2S.

OK submits configuration changes to the LaCie Biggest S2S and closes the Configuration Mode.

Cancel aborts the changes and closes the Configuration Mode.

•

•

•

The toolbar of the Basic Configuration Mode win-
dow includes icons that enable functions of the Advance 
Configuration Mode. Please see chapter 4.4.2. The Ad-
vance Configuration Mode for details. 
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4.4.1.1. Configure JBOD (Bypass)

In a JBOD configuration, each physical disk is in-
dependent and is mapped completely to its logical vol-
ume. 

To create a JBOD volume

To open the Configuration Mode, select Configure 
Box in the Edit menu or the corresponding button in 
the Status window.

 Select the JBOD radio button from the Configura-
tion Mode frame.

1.

2.

Technical note: The volumes table below 
the Storage Policy frame lists the volume label, 
implemented storage policy and size.

3. A confirmation box appears.  Because the Basic Con-
figuration Mode affects all hard disk drives, a con-
figuration change may result in total data loss. Click 
Yes to complete the configuration.

4. Select Save to Config File from the File menu or 
click the button in the toolbar to save the configura-
tion.

5. Click the OK button to build the configuration in 
the Configuration Mode window. This configures the 
drives using the JBOD storage policy.

Within a minute, the Status window will reflect the 
implemented JBOD storage policy.

 6. Partition the configured volume to complete the im-
plementation. See 4.4.3. Partition Configured Vol-
ume, for details.
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4.4.1.2. Configure Safe

For the Safe storage policy, the Basic Configuration 
Mode creates two volumes. Two hard disk drives make 
up each volume and mirror each other. The remaining 
hard disk drive is specified as a Hot Spare for both vol-
umes.

To create a Safe volume

To open the Configuration Mode, select Configure 
Box in the Edit menu or the corresponding button in 
the Status window.

 Select the Safe radio button from the Configuration 
Mode frame.

1.

2.

3. A confirmation box appears.  Because the Basic Con-
figuration Mode affects all hard disk drives, a con-
figuration change may result in total data loss. Click 
Yes to complete the configuration.

Technical note: The volumes table below 
the Storage Policy frame lists the volume label, 
implemented storage policy and size.

4. Select Save to Config File from the File menu or 
click the button in the toolbar to save the configura-
tion.

5. Click the OK button to build the configuration in 
the Configuration Mode window. This configures the 
drives using the Safe storage policy.

Within a minute, the Status window will reflect the 
implemented Safe storage policy. Disk #0 and Disk #1 
are allocated to Safe Volume #0. Disk #2 and Disk #3 
are allocated to Volume #1. Disk #4 is designated as the 
Hot Spare.

 6. Partition the configured volume to complete the im-
plementation. See 4.4.3. Partition Configured Vol-
ume, for details.
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4.4.1.3. Configure Fast

For the Fast storage policy, the Basic Configuration 
Mode creates a single volume of four hard disk drives in 
a striped format. The remaining hard disk drive is des-
ignated as a standalone volume using the BIG storage 
policy. Note that the LaCie Biggest S2S Storage Appli-
ance is set to a Fast configuration by default.

To create a Fast volume

To open the Configuration Mode, select Configure 
Box in the Edit menu or the corresponding button in 
the Status window.

 Select the Fast radio button from the Configuration 
Mode frame.

1.

2.

3. A confirmation box appears.  Because the Basic Con-
figuration Mode affects all hard disk drives, a con-
figuration change may result in total data loss. Click 
Yes to complete the configuration.

Technical note: The volumes table below 
the Storage Policy frame lists the volume label, 
implemented storage policy and size.

4. Select Save to Config File from the File menu or 
click the button in the toolbar to save the configura-
tion.

5. Click the OK button to build the configuration in 
the Configuration Mode window. This configures the 
drives using the Fast storage policy.

Within a minute, the Status window will reflect the 
implemented Fast storage policy configuration.

 6. Partition the configured volume to complete the im-
plementation. See 4.4.3. Partition Configured Vol-
ume, for details.
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4.4.1.4. Configure Big

The Basic Configuration Mode implements the Big 
storage policy by concatenating all the hard disk drives 
into a single volume. Before reconfiguring the Biggest 
S2S, delete previously defined partitions. See 4.4.3. Par-
tition Configured Volume, for details. 

To create a Big volume

To open the Configuration Mode, select Configure 
Box in the Edit menu or the corresponding button in 
the Status window.

 Select the Big radio button from the Configuration 
Mode frame.

1.

2.

3. A confirmation box appears.  Because the Basic Con-
figuration Mode affects all hard disk drives, a con-
figuration change may result in total data loss. Click 
Yes to complete the configuration.

Technical note: The volumes table below 
the Storage Policy frame lists the volume label, 
implemented storage policy and size.

4. Select Save to Config File from the File menu or 
click the button in the toolbar to save the configura-
tion.

5. Click OK to build the configuration and close Con-
figuration Mode window. This configures the drives 
using the Big storage policy. Within a minute, the 
Status window will reflect the  implemented Big 
storage policy configuration.

 6. Partition the configured volume to complete the im-
plementation. See 4.4.3. Partition Configured Vol-
ume, for details.
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4.4.1.5. Configure Safe + Big

The Safe + Big storage policy configuration mirrors 
the concatenated disks to create a volume consisting of 
four disk drives. The Basic Configuration Mode des-
ignates the remaining hard disk drive as a Hot Spare. 
Before reconfiguring the Biggest S2S, delete previously 
defined partitions. See 4.4.3. Partition Configured Vol-
ume, for details.

To create a Safe + Big volume

To open the Configuration Mode, select Configure 
Box in the Edit menu or the corresponding button in 
the Status window.

 Select the Safe + Big radio button from the Con-
figuration Mode frame.

1.

2.

3. A confirmation box appears.  Because the Basic Con-
figuration Mode affects all hard disk drives, a con-
figuration change may result in total data loss. Click 
Yes to complete the configuration.

Technical note: The volumes table below 
the Storage Policy frame lists the volume label, 
implemented storage policy and size.

4. Select Save to Config File from the File menu or 
click the button in the toolbar to save the configura-
tion.

5. Click OK to build the configuration and close Con-
figuration Mode window. This configures the drives 
using the Safe + Big storage policy. 

Within a minute, the Status window will reflect the 
implemented Safe + Big storage policy configuration. 
Drive #4 is designated as the Hot Spare. The remaining 
hard disk drives are allocated to the Safe + Big volume.

 6. Partition the configured volume to complete the im-
plementation. See 4.4.3. Partition Configured Vol-
ume, for details.
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4.4.1.6. Configure Safe + Fast

In the Safe + Fast storage policy, data is written to 
mirrored disks in a striped format to create a volume 
consisting of four disk drives. The Basic Configuration 
Mode designates the remaining hard disk drive as the 
Hot Spare.

To create a Safe + Fast volume

To open the Configuration Mode, select Configure 
Box in the Edit menu or the corresponding button in 
the Status window.

 Select the Safe + Fast radio button from the Con-
figuration Mode frame.

1.

2.

3. A confirmation box appears.  Because the Basic Con-
figuration Mode affects all hard disk drives, a con-
figuration change may result in total data loss. Click 
Yes to complete the configuration.

Technical note: The volumes table below 
the Storage Policy frame lists the volume label, 
implemented storage policy and size.

4. Select Save to Config File from the File menu or 
click the button in the toolbar to save the configura-
tion.

5. Click OK to build the configuration and close Con-
figuration Mode window. This configures the drives 
using the Safe + Fast storage policy. 

Within a minute, the Status window will reflect the 
implemented Safe + Fast storage policy configuration.

 6. Partition the configured volume to complete the im-
plementation. See 4.4.3. Partition Configured Vol-
ume, for details.
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4.4.2. Advanced Configuration Mode

This section describes how to use the Advanced 
Configuration Mode to apply more than one storage 
policy to volumes on the LaCie Biggest S2S.

The Basic Configuration Mode provides six pre-
defined storage policies to quickly configure the LaCie 
Biggest S2S. Each predefined storage policy allocates 
the maximum system capacity to the selected storage 
policy. Using the Advanced Configuration Mode, you 
can configure up to ten volumes - each with different 

storage policies and capacities. This flexibility provides 
numerous combinations of performance, redundancy, 
and capacity to meet your business requirements. 

There are many of the possible combinations of stor-
age policy and capacity allocations that you can create 
with the Advanced Configuration Mode. Experiment 
with other combinations to allocate the total system ca-
pacity to meet your needs.

4.4.2.1. A Look at the Advanced Configuration Mode

The Advanced Configuration Mode is an extension 
of Basic mode that allows you to create two volumes 
(virtual drives) on each physical hard disk drive.  See the 

following page for a diagram identifying the Advanced 
Configuration Mode’s Sections and toolbar buttons.



LaCie Biggest S2S
User Manual page 40

4.4.2.2. Advanced Configuration Mode Sections

Using Your Biggest S2S

Storage Policy shows the available storage poli-
cies that you can assign to volumes. The options 
are enabled after you create a new volume or se-
lect an existing volume to edit.

Drive Graph shows Volume, Mode (storage 
policy), and Size details for currently configured 
volumes. Select a volume to edit or delete it. The 
Total GB’s Left field beneath the volume list 
shows the remaining capacity in gigabytes for all 
the hard disk drives.

Volumes displays disk space for each hard disk 
drive. All space allocated to the same volume ap-
pears in a matching color. A hatch pattern indi-
cates a proposed configuration and a solid block 
indicates an existing volume.

List permits volume creation and modification 
on each hard disk drive:

Hot Spare check box indicates space on this 
drive is allocated as rebuild space for the selected 
SAFE volume. 

n ‘Use’ check box indicates drive membership 
within a volume.

n Slider specifies capacity allocated to a volume. 

n Text field shows the capacity specified by ma-
nipulating the slider.

n ‘Cap’ field shows maximum capacity for the 
hard disk drive. 

n ‘Vol#’ shows the virtual volume with which 
each hard disk drive is associated.

1

2

3

4

1

2

3

4
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4.4.2.2.1. Toolbar buttons

Button Function Button Function

Reads a saved configuration into the Advanced 
Configuration Mode so you can apply the con-
figuration to the LaCie Biggest S2S. Available in 
Basic and Advanced modes.

Permits the storage policy and capacity of an 
existing volume to be modified.

Saves a configuration to a file on the host com-
puter. Available in Basic and Advanced modes.

Deletes the volume that is currently selected 
in the volume list.

Cancels proposed changes. Available in Basic and 
Advanced modes.

Deletes all configured volumes.

Creates a new volume on which to set the stor-
age policy and capacity. You can create up to 2 
volumes on each hard disk drive (10 total).

Copies the configuration of one LaCie Big-
gest S2S to the current LaCie Biggest S2S. 

4.4.2.2.2. Command buttons

Button Function

To Basic Mode Opens the Basic Configuration Mode

Update Volume
Applies the selected storage policy to a specific portion of a hard disk drive as a proposed configura-
tion

Cancel
Aborts the pending changes and returns the Advanced Mode to the point where you can perform 
different advanced configuration functions

Apply
Submits configuration changes to the Biggest S2S, closes the Advanced Mode, and displays the 
updated configuration on the Status window

Cancel Aborts the in-progress changes and closes the Advanced Mode



LaCie Biggest S2S
User Manual page 42

Using Your Biggest S2S

4.4.2.3. Configuring Multiple Volumes

The Advanced Configuration Mode allows many 
combinations of storage policies and capacities. The fol-
lowing procedure shows how to modify a basic SAFE 
configuration so that it contains several volumes, each 
with different storage policies. This example illustrates 
one possible combination that allocates all of the sys-
tem’s available capacity to:

One 50-gigabyte (GB) SAFE volume on drives 0 
and 1, with no reserved space for a Hot Spare. 

 One FAST volume that uses the remaining capacity 
on drives 0 and 1.

 One BIG volume that uses all of the capacity on 
drives 2, 3, and 4.

The same sequence of steps applies to any configura-
tion you choose to implement; only the storage policy 
and capacity allocation vary for different configuration 
options.

1. Click the Configure Box toolbar button to open the 
Basic Configuration Mode.

2. Click the button labeled To Advanced Mode to open 
the Advanced Configuration Mode.

3. Select the Delete all volumes from the toolbar.

4. When prompted to confirm the deletion of the vol-
umes, click Yes.

•

•

•

Important Info: Before reconfiguring an 
existing LaCie Biggest S2S with a new configura-
tion, back-up the data. Use the Disk Management 
utility provided by your OS to delete all Biggest 
S2S - except the unallocated, un-initialized disk 
that represents the LaCie processor. Once the con-
figuration and partitioning of the new volumes has 
taken place, it is safe to restore the backed-up data 
to the new configuration. See chapter 4.4.3. Parti-
tioning Configured Volumes for details.

A
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5. Select Create a new volume (B) from the toolbar. 

B

Technical note: Click to the right or left 
of the slider within the slider’s channel to make 
half-GB changes.

6. Select SAFE (RAID 1) as the Storage Policy.  Click 
on the Use check boxes underneath Drives 0 and 1.  
Move the slide to 50. 

7. Click Update Volume.

8. When prompted whether to create a Hot Spare for 
the SAFE volume, click No.  In some configurations, 
you may want the added redundancy of a Hot Spare.  
The goal of this example is to use all available system 
capacity to deliberately avoid the Hot Spare.

9. Click the Create a New Volume toolbar button.
Cross-hatches identify allocated space for updated 
volumes (not yet saved).  Light solid colors identify 
unallocated disk space.
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10. Select the FAST radio button in the Storage Policy 
section.

11. Select the Use check box beneath both Drive 0 and 
Drive 1. This example illustrates two-drive striping.

12. Move the slider beneath Drive 0 all the way to the 
right to allocate the remaining capacity on the two 
drives to the Fast volume.

If you wish, you can allocate less than the total re-
maining capacity to the new volume. However, do-
ing so makes the unallocated capacity unavailable 
and unused.

13. Click Update Volume.

14. Click the Create a New Volume toolbar button.

15. Select the BIG radio button in the Storage Policy 
section.

16. Select the Use check box beneath Drive 2, Drive 3, 
and Drive 4 to allocate all of the remaining system 
capacity to the BIG volume.

17. Click Update Volume.

Important Info: Only the last Volume 
listed (in the above example, Volume 2) can be ed-
ited.  In order to edit Volume 1, Volume 2 must be 
deleted.  In order to edit Volume 0, all Volumes 
must be deleted and the end-user will need to start 
with a New Volume.
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18. Click the Write Configuration for System to a File 
toolbar button to save the configuration.

19. Click Apply to create the multi-volume configura-
tion, close the Advanced Mode, and display the vol-
umes in the Status window (within a minute or so).

20. Partition the configured volumes to complete the 
implementation. See chapter 4.4.3. Partitioning 
Configured Volumes for details.

Using Your Biggest S2S

4.4.2.4. Managing Configuration Files

The Basic Configuration Mode provides menus and 
icons to manage configuration files.

The Read Config File command from the File menu 
in the Basic Configuration Mode imports a configu-
ration file so that the end-user can restore a previ-
ously saved configuration (storage policy).

The Save to Config File command from the File 
menu in the Basic Configuration Mode exports an 

•

•

Biggest S2S configuration to a file.

Each of the procedures in chapter 4.4.1. Basic Con-
figuration prompts you to save a configuration file.

4.4.2.4.1. Importing a Configuration File

Select Configure Box from the Edit menu or click 
the Configure Box toolbar button in the Status win-
dow to open the Basic Configuration Mode.

Select Read Config File from the File menu in the 
Basic Configuration Mode.

1.

2.

Navigate to the required file and click Open to im-
port it.  The Basic Configuration Mode provides no-
tice of a successful import and graphically displays 
the imported volumes.

Click OK to implement the imported configuration.

3.

4.

4.4.2.4.2. Saving a Configuration File

Select Configure Box from the Edit menu or click 
the Configure Box toolbar button in the Status win-
dow to open the Basic Configuration Mode.

Select Save to Config File from the File menu in the 

1.

2.

Basic Configuration Mode. 

Navigate to the appropriate directory, specify a file 
name in the File Name text box, and click the Save 
button.

3.

Technical note: You must have previously 
saved a configuration file for one to be available for 
import. See chapter 4.4.2.3.2. Save a configuration 
file for details.
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The configured volume must be partitioned for use 
by the Windows operating system before you can begin 
using it. 

The following example describes the procedures re-
quired to partition a volume. Microsoft Windows al-
lows you to further segment the configured volume into 
smaller logical drives, if desired.

Note that when you reconfigure a volume, you must 
first delete previously-defined partition(s).

To partition a volume

Review the Configure JBOD section configuration. 
This example uses the JBOD storage policy for creat-
ing a volume for each hard disk drive.

Right click your My Computer icon and select Man-
age from the pop-up window. From the Computer 
Management Window select Disk Management 
under Storage to open Windows Disk Manager.

1.

2.

4.4.3. Partition Configured Volume

4.4.3.1. Windows Users

3.  Right click on the configured disk’s unallocated space 
and select New Partition. If they new partition op-
tion is not available, select the disk and initialize it 
first.
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4.  Click Next to start the Partition Mode.

Using Your Biggest S2S

5.  Select the Primary or Extended option and click 
Next.

6.  Specify partition size. The default shows the entire 
volume capacity. If you choose to use a portion of the 
space, enter the partition size and click Next.
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7.  Assign a drive letter or mount path and click Next.

Using Your Biggest S2S

8.  Name and format the partition and click Next.

9.  Review the file system settings and click Finish to 
create the logical partitions.
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10.  Note the properties selected for the logical partition 
in the Disk Manager.

11. Repeat the procedures 1-9 to partition any of the 
remaining disks.

Using Your Biggest S2S

1. Review the Configure JBOD (Bypass) section. This 
example uses the JBOD storage policy to directly ex-
pose each hard disk drive.

4.4.3.2. Partition configured volume — Mac OS X

2. Launch Disk Utility from Application/Utilities fold-
er to view the disk drives.

3. Select a configured disk and click Partition tab. 

4. Select 1 Partition from the Volume Scheme drop 
down.

5. Enter a name for the volume in the Name field.

6. Select Mac OS Extended (journaled) from the For-
mat drop down.

7. Specify the size of the Partition within the Size field.

8. Click Partition button.
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9. Click Partition to acknowledge the warning.

The Disk Utility will mount the created partition 
and represent it with an icon on the desktop.

Using Your Biggest S2S

4.4.4. Manage Configuration Files

The LaCie Biggest S2S Manager supports volume 
configuration backup, and restoration. This feature al-
lows creation of configuration templates that can be 
distributed across multiple workstations. In addition, 
backups can be used to restore volume configuration on 
to a replacement unit. 

The Status and the Configuration Mode windows 
provide menus and icons to manage configuration files. 
The LaCie Biggest S2S Manager imports a configura-
tion file using the Read Config File under the File menu 

in the Configuration Mode. The LaCie Biggest S2S 
Manager exports a configuration file using the Save to 
Config File under the File menu of the Configuration 
Mode.

Technical note: You can import a config-
uration file from the Status window but its policy 
can only be implemented using the Configuration 
Mode.

4.4.4.1. To Import a File

1. Select Read Config File in the File menu of the  
Configuration Manager window.

2. Navigate to the required file and click Open to 		
import it. The Configuration Mode provides notice of a 
successful import and graphically displays the imported 
volumes.

3. Click OK to implement the imported configura-
tion.
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4.4.4.2. To Export a File

Select Save to Config File in the File menu of the 
Configuration Mode window.

Navigate to the appropriate directory, specify a file 
name in the File Name text box and click the Save 
button.

1.

2.

4.4.5. Manage Client Connection to the Daemon

The LaCie Biggest S2S Manager consists of two 
modules: 

Daemon 

User interface 

The daemon module monitors the LaCie Biggest 
S2S status and performs Safe volume rebuilds auto-
matically. By default, the user interface attaches to a 
daemon running on the same PC to display the infor-
mation gathered by the daemon. The user interface may 
also be configured to display information tracked by a 
daemon module running on a remote PC that is in the 
same room or at a different site. Having the user inter-
face remote to the daemon allows remote monitoring 
for system fan and hard disk drive failures. Identification 
of a failed part may then allow the service provider to 
replace failed components before further complications. 
The daemon module listens for connections on TCP 
port 51115. Do not change this port number.

•

•

Prerequisites

Ensure you have the following before you establish 
the remote connection:

 The daemon is running on the PC, local to the LaCie 
Biggest S2S.

The Configuration Manager user interface module is 
running remotely.

A TCP/IP connection can be established between 
the daemon listening on port 51115 and the user in-
terface.

To set up a remote connection

Open the File menu in the Status window and select 
Change connection.

•

•

•

1.
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2.  Enter the hostname or IP address of the PC hosting 
the daemon. Click OK.

3.  The user interface established the requested connec-
tion and displays the information gathered by the 
remote daemon in the Status window.

Using Your Biggest S2S

4.4.6. Email Notification

The Email Notification feature allows the end-user 
to have the Biggest S2S Manager send an email if any of 
the following conditions/situations occur:

Each of the above conditions can be customized for 
sending options as well as the message that is sent.

This is an example of the Setup Email Notification 
screen.

Partition Rebuild Start
Partition Verify Start
Partition Rebuild 
Resume
System Fan Too Slow
No Boxes Found
Drive Unplugged

•
•
•

•
•
•

Partition Rebuild 
Complete
Partition Verify 
Complete
Temperature Too High
Power supply Fan Too 
Slow
Box Removed
Drive Inserted

•

•

•
•

•
•

Technical note: Please note that  once 
installed, the GUI does not need to be running 
on your system to send an email notification. Your 
system (PC or Mac) needs to be turned on, how-
ever, to receive email notifications.
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4.4.6.1. Setting Up Email Notification

Using Your Biggest S2S

c. The message information can be customized to suit 
the end-user’s needs.  The Daemon can extract the 
following data from the Biggest S2S hardware:

1. The box available for the SMTP Server Name can be 
left blank.  The Biggest S2S Manager will perform a 
DNS lookup and automatically find the correct ad-
dress. 

2. The box available for the SMTP Server Port# uses 
Port 25 as a default.

3. The From, To, and CC boxes are for specifying the 
intended receivers of the condition notifications.

4. Select Test Email at the bottom of the screen to ver-
ify that you have correctly set-up the email portions 
of this feature.

5. The Email Notification feature also allows the end-
user to customize a message for each of the line items 
(of which each has its own default message already 
built in).  For instance, if the end-user wants to edit 
the message for Drive Unplugged…

a. Click on the Message box.

b. The following will appear:

Technical note: In the From: box, the 
you should type in your own email address.

Symbol Result

$B Box serial number

$T Current temperature

$DS Drive serial number

$SF System fan OK flag

$DN Drive id [slot #]

$PSF Power supply fan OK flag

$V Current volume
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d. If there is information that the end-user would 
like included in the error message, s/he can enter 
it themselves by typing in a selected message code 
listed above.  For instance: to put in the Box Serial 
Number, type in the descriptive text followed by 
the message code as demonstrated below. 

e. Click on Accept to complete the change.

Using Your Biggest S2S

4.4.6.2. Receiving an Email Notification

When one of the conditions/situations occurs, a 
pop-up appears on the host computer stating that a 
email has been sent.

The email received from the Biggest S2S will look 
like this:
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5. Maintaining Your Biggest S2S

5.1. Removing/Replacing a Drive

In the event that an individual hard disk fails in the 
LaCie Biggest S2S, please contact your LaCie reseller or 
LaCie Customer Support. Additional, spare Drive Bays 
with pre-installed hard disks may also be purchased 
(sold separately).

CAUTION: Do NOT attempt to replace a hard 
disk yourself. Removing a hard disk from a Drive 
Bay will void the warranty.

5.2. Install New Firmware (Upgrade)

The LaCie Biggest S2S may periodically have re-
leases of updated firmware. Visit LaCie’s Web site, 
www.lacie.com, for the latest firmware update. Ex-
perienced system administrators may want to install 
the latest firmware available for the LaCie Biggest S2S 
Storage Appliance and can reset the Biggest S2S should 
that become necessary.

Install new firmware

Select Specify Firmware from the Edit menu of the 
Status window. 

The firmware selection dialog shows all of the Big-
gest S2Ss attached to the PC, the current firmware 
for each Storage Appliance, and the circuit board re-
vision for each Biggest S2S.

Select The Biggest S2S requiring an update. 

Enter the name of the new firmware you would like 
to use in the Update firmware from file text box or 
click Browse to find the file on a CD or hard disk. 

Click Install Firmware to begin the upgrade.

1.

2.

3.

4.

5.

Technical note: HyperTerminal is a 
standard bundle with the Microsoft Windows op-
erating system, and is located in the Communica-
tions folder. If you do not have a version installed, 
it may be downloaded from Hilgraeve Software, at 
http://www.hilgraeve.com/htpe/

Important Info: Array configuration and 
data are not affected by firmware updates.



LaCie Biggest S2S
User Manual page 56

Maintaining Your Biggest S2S

5.3. Configure Safe Volume Rebuild Storage Policy

This LaCie Biggest S2S feature is provided to man-
age rebuilds of Safe volumes. 

When is a rebuild necessary?

A rebuild is initiated to restore data redundancy for 
a Safe volume that has entered a vulnerable state. In a 
vulnerable state, one of the two mirrored disks goes of-
fline or is inaccessible. Although the Safe volume re-
mains available during the rebuild process, the volume is 
susceptible to data loss through damage of the remain-
ing disk until data redundancy is restored through a re-
build.

The rebuild feature also applies to other policies such 
as Safe + Big and Safe + Fast.

What happens during a rebuild?

The rebuild process restores data redundancy by first 
utilizing space allocated for a Hot Spare. In case Hot 
Spare space does not exist or has already been rebuilt, 
the Biggest S2S processor rebuilds to empty space on a 
hard disk drive other than the one containing vulnerable 
data. Following a rebuild, it is not necessary to designate 
space to a Hot Spare for a subsequent rebuild to occur.

With Automatic Rebuild and Immediate Rebuild 
options selected, the daemon module of the Biggest S2S 
Manager automatically initiates an immediate rebuild. 
Alternatively, the daemon may be configured to delay 
rebuild until the first write to the Safe volume and the 
rebuild is absolutely necessary by selecting the Rebuild 
Only If Needed option. The latter setup allows tempo-
rary removal of a hard disk drive without requiring a 
rebuild. To minimize the possibility of data loss, the re-
build process should be set up to launch immediately.

With Manual Rebuild selected, the user decides 
when to initiate rebuild following a rebuild prompt. 
Unless the Biggest S2S Manager is actively monitored, 
the Automatic rebuild should be set up to minimize the 
possibility of data loss.
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In case you select No in response to a rebuild prompt, 
select Scan Devices from the File menu of the Status 
window to trigger a new prompt.  If a power failure in-
terrupts a rebuild, the daemon will restart the rebuild 
process.

To configure a rebuild 

1. Select Specify Policy under the Edit menu of the 
Status window.

2. Select one of the following policy options:

• The Manual rebuild radio button requires a user to 
manually initiate a rebuild of the volume.

• The Automatic rebuild option forces the daemon to 
initiate the rebuild process automatically and mini-
mize the possibility of data loss. 

3. If you select the automatic rebuild option you have 
the following choices within the Automatic Rebuild 
Options frame.

• The daemon can be configured to perform an Im-
mediate Rebuild following detection of an offline 
hard disk drive. 

• The Rebuild Only If Needed option will delay the 
rebuild for a Safe volume with an offline hard disk 
drive until the write occurs to the Safe volume.

4. Click the Accept button to commit the selected op-
tions.

The daemon uses the specified rebuild policy to 
maintain redundancy. The Status window displays a re-
build in progress.

Maintaining Your Biggest S2S
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Review the color of the drives in the Status window. 
A change in color indicates a change in the following 
drive states:

6. Monitor the LaCie Biggest S2S Storage Appliance

Use the Status window to monitor the LaCie Big-
gest S2S Storage Appliance.

6.1. To Monitor Drive Status

Color Definition Solution

Green The drive is active.

Red The drive is in a failed state.  That is, a write has occurred to a 
Safe volume while the disk drive was offline.

Replace the failed drive.

Rose The drive is offline or unplugged. Verify that the disc is securely in the bay.

Fuschia New drive.

Yellow The drive is being rebuilt.

Purple There’s a mismatch between the Serial # and Expected Serial # 
because a hard disk drive has been installed into the wrong bay.

Plug the correct disk drive into the bay.
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The LaCie Biggest S2S uses the following colors to 
indicate temperature malfunctions.

6.2. To Monitor Temperature

Color Definition Solution

White Temperature is normal.

Yellow Temperature is greater than 40° C (104° F Verify that there are no obstructions to airflow in the front and 
back of the LaCie Biggest S2S unit.

Red Temperature is greater than 45° C (113° F) Ensure constant airflow at the back of the unit. If there is no 
airflow, replace the fan. Identify the disk drive causing the 
temperature increase. Replace the disk drive.
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Front Panel LED Indicators

Each disk drive and the host connection have two 
LEDs to indicate drive status and/or host communica-
tion status, see Figure 2. LED 0 is on the left, and is 
typically blue; LED 1 is on the right and is typically 
green. 

Additionally, there are two error-condition lights 
that are available for troubleshooting.

When the LaCie Biggest S2S is powered on, the •

host scans the disks in sequence, as indicated by a 
brief flash of lights on LED 1. Once the host scan 
is complete, LED 1 is lit for each drive present.  

During disk operations, LED 0 flashes as data is 
transferred to and from the drive and the host. If a 
Safe volume is being rebuilt, LED 1 blinks slowly 
on both mirrored disks.

•

7. LaCie Biggest S2S Front Panel LED Indicators

LED O LED 1

! LED OK LED

! OK Description

Off On Startup or ON indication. 
OK LED will flash during 
reset and will remain green in 
all other cases.

On Error The “!” LED will light as a 
result of 	an EEPROM error 
during boot or following a 
run time error.

LED 0 LED 1 Description

Off Off Power On, No device at-
tached

Off On PHY communication estab-
lished, (Activity = LED0 On)

On Blink Rebuild

Blink Blink Error
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Tech Tips

Each disk drive and the host connection have two 
LEDs to indicate drive status and/or host communica-
tion status, see Figure 2. LED 0 is on the left, and is 
typically blue; LED 1 is on the right and is typically 
green. 

Additionally, there are two error-condition lights 
that are available for troubleshooting.

When the LaCie Biggest S2S is powered on, the 
host scans the disks in sequence, as indicated by a 
brief flash of lights on LED 1. Once the host scan 
is complete, LED 1 is lit for each drive present.  

During disk operations, LED 0 flashes as data is 
transferred to and from the drive and the host. If a 
Safe volume is being rebuilt, LED 1 blinks slowly 
on both mirrored disks.

•

•

8. Tech Tips

8.1. Available Storage Capacity

Technical note: Storage capacity of an 
array depends on the RAID level. The capacity of 
a RAID array can be found by multiplying the ca-
pacity of the drives in the array by the number of 
non-redundant drives.
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8.2. File System Formats

You have the option of formatting the drive in one 
of four formats: Mac OS Standard (HFS), Mac OS Ex-
tended (HFS+), MS-DOS File System and UNIX File 
System (UFS).

n HFS - Mac OS Standard
Mac OS Standard refers to the file system used by 

Mac OS 8.0 and earlier. This is no longer a modern file 
sytem  specification, and Mac OS Extended is more ef-
ficient. Only use this file system if you are creating a 
volume smaller than 32MB, using a Mac with a 680X0 
processor, or you are creating a file structure that will be 
need to be used by Macs using Mac OS 8.0 or earlier.

n HFS+ - Mac OS Extended 
Mac OS Extended refers to the file system used by 

Mac OS 8.1 and later. HFS+ represents an optimization 
of the older HFS file system by using hard disk space 
more efficiently. Building off of HFS, they increased 
the number of blocks from 65,536 to 4.29 billion. With 
HFS+, you are no longer limited by block size. 

n MS-DOS File System
This is the Microsoft file system, more typically 

known as FAT 32. This is the file system to use if you 
are going to be using your LaCie d2 TV Hard Drive 
between Macs and Windows operating systems.  Single 
file size is limited to 4 GB*. File name length is also 
limited.

n UNIX File System
This is the file system based on UNIX, and is pref-

erable for users developing UNIX-based applications 
within Mac OS 10.x. Unless you have a specific reason 
to use the UNIX File System, you should instead format 
your drive using Mac OS Extended (HFS+), because it 
provides Mac users with a more familiar operating ex-
perience.

Tech Tips

Technical note: Mac OS 10.3.x Users 
- Mac OS Extended ( Journaled) Under Panther, 
Apple introduced journaling to the Mac OS Ex-
tended file system, which helps protect the file 
systems on Mac OS volumes. When journaling 
is enabled, file system transactions are maintained 
and recorded continuously in a separate file, called 
a journal. In the event of an unplanned shutdown, 
the OS uses the journal to restore the file system. 
Journaling is also backward compatible, and all 
volumes with journaling enabled can be fully used 
by computers not running Mac OS 10.3.x. For 
more information, please visit Apple’s Web site.

Important Info: If you will be sharing the 
hard drive between Mac and Windows operating 
environments, you will want to follow these guide-
lines:

Mac OS X prefers that all partitions be the same 
format, therefore only the first FAT 32 partition is 
guaranteed to mount.

Mac OS 10.1.x -
• Works reliably with FAT 32 partitions less than 

32GB

Mac OS 10.2.x -
• Works reliably with FAT 32 partitions less than 
128GB

• Does not mount FAT 32 partitions greater than 
128GB

Mac OS 10.3.x -
• Mounts any FAT 32 drive of any size
• Mounts NTFS volumes as READ-only

8.2.1. Mac Users
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Since the LaCie Biggest S2S comes preformatted 
in HFS+, the Mac Operating system, yu will need to 
reformat your drive in FAT 32 or NTFS. The following 
information will hopefully make choosing one or the 
other a little easier. 

n FAT 32 
FAT is an acronym for File Allocation Table, which 

dates back to the  beginnings of DOS programming. 
Originally, FAT was only 16 bits, but after the second 
release of Windows 95 it was upgraded to 32 bits, hence 
the name FAT 32. In theory, FAT 32 volume sizes can 
range from less than 1MB all the way to 2TB. It is the 
native file system of Windows 98 and Windows Me, 
and is supported by Windows 2000 and XP. When FAT 
32 is used with Windows 2000 and XP, though, vol-
ume size is limited to 32GB (by the Windows partition 
utility, i.e. Disk Manager), and the individual file size is 
limited to 4GB.

n NTFS 
This acronym stands for New Technology Filing 

System, and it is the native file system for Windows NT, 
Windows 2000 and XP. NTFS offers several features 
that are not available with FAT 32; i.e. file compres-
sion, encryption, permissions, and auditing, as well as 
the ability to mirror drives and RAID 5 capabilities. 
The minimum supported volume size for NTFS is 
10MB, with a maximum of 2TB, with no limit to file 
size. Volumes created in NTFS can only be directly ac-
cessed (not through shares) by Windows NT, Windows 

2000 and XP, without resorting to help from third-party 
products.

Guidelines for Choosing FAT 32 Or NTFS

n Use FAT 32 if:
You want to access your data on any Operating Sys-
tem - FAT 32 is compatible with Windows 98 SE, 
Me, 2000, XP, NT, Mac OS 9.x and Mac OS 10.x 
(see the Important Info note in section 8.2.1. Mac 
Users for more information).

You will be dual booting with an Operating System 
other than Windows NT or Windows 2000.

You may need the ability to dual boot down the line. 
Once you have converted a volume from FAT 32 to 
NTFS, there is no going back. You can convert from 
FAT 32 to NTFS, but not the other way around.

n Use NTFS if:
You want to optimize drive performance under Win-
dows 2000 or XP.

You want to encrypt files, assign permissions to files, 
or want to audit files for access.

You will be formatting partitions larger than 32GB.

You need to store individual files that are larger than 
4GB.

You need a filing system that can be mirrored or 
structured like a RAID 5 configuration.

•

•

•

•

•

•

•

•

8.2.2. Windows Users

Tech Tips



LaCie Biggest S2S
User Manual page 64

Tech Tips

n What is Serial ATA II?

The Serial Advanced Technology Attachment (ATA) 
II marks the latest rung on the evolutionary ladder of 
SATA technology. SATA II can deliver data at 300MB/
s, twice as fast as its SATA predecessor and more than 
twice as fast as the Parallel ATA/ IDE (Integrated Drive 
Electronics) interface, which has long been used to con-
nect peripheral devices to the computer. Initial Serial 
ATA technology removed the performance bottleneck 
of the Parallel ATA specification, and follows a clearly 
defined road-map to greater and greater data transfer 
rates and feature improvements.

Deriving its name from the way that it transmits sig-
nals, in a single stream, or serially, Serial ATA operates 
in a point-to-point topology. This connectivity method-
ology delivers the entire available interface bandwidth 
to each device, allowing each device to operate at its 
maximum throughput, and provides direct communi-
cation between the device and the system at any time, 
reducing arbitration delays associated with shared bus 
topologies. 

n What are the key differences between Serial ATA 
and Serial ATA II technology?

SATA I requires that parallel ATA drives be config-
ured as master and slave and daisy-chained from each 
controller. Not so with SATA II. In addition to deliver-
ing data at twice the speed of SATA, SATA II also fea-
tures port-multiplier options allowing for many drives 
to be connected to a SATA II controller. 

n What are the features and benefits of Serial ATA 
and Serial ATA II?

The Serial ATA specification provides several key 
features that will help spur widespread implementa-
tion:

Performance: Serial ATA is a point-to-point topol-
ogy, and does not have to share the bus, instead dedi-
cating full bandwidth to the device. These dedicated 
links make creating a Serial ATA RAID array quick 
and relatively inexpensive to implement.

Easy installation and configuration: There are no de-
vice IDs, termination or master/slave conflicts, and 
the standard supports hot-plug connectivity. Drives 
can be added, upgraded or removed without having 
to power down the whole system.

Improved reliability: Serial ATA also uses 32-bit cy-
clic redundancy checking (CRC) on all transfers to 
ensure correct data transmissions. Due to this CRC 
capability, Serial ATA performs protection and re-
covery features at multiple levels: PHY layer, link 
layer and transport and software layers.

Command optimization: Serial ATA utilizes Na-
tive Command Queing (NCQ) and first party direct 
memory access (DMA) to intelligently order com-
mands in an internal queue within the drive, with-
out having to involve the host CPU. Judging its own 
drive head’s angular and rotational position, the drive 
selects a data transfer from the queue that will mini-
mize both its seek and rotational latencies.

Simplified structure: Serial ATA utilizes a more ef-
ficient signaling voltage (250mV vs. 5V for Parallel 
ATA), and much smaller, thinner and compact cables 
and connectors. Due to the simplified cabling (the 
reduction in the number of pins and wires), the num-
ber of fault possibilities decreases.

Seamless integration: Serial ATA maintains register 
and software compatibility with Parallel ATA, and 
should be transparent to both the BIOS and oper-
ating system. Simply add more Serial ATA links to 
increase the number of connectivity points in your 
system.

•

•

•

•

•

•

8.3. Serial ATA II Questions and Answers
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n What are the ideal uses of Serial ATA?

Although the specification supports all ATA and 
ATAPI devices (i.e. CD, DVD, tape drives, etc.), and 
delivers superior performance than both Hi-Speed USB 
2.0 and FireWire/IEEE 1394, external Serial ATA con-
nectors are intended for storage devices. Serial ATA 
works best in storage environments that require high 
data throughput to deliver large files quickly and effi-
ciently, maximizing the storage systems utilization and 
enhancing overall productivity.

Due to its performance, reliability, scalability and 
cost-effectiveness, Serial ATA can be implemented in a 
wide-range of settings, from desktop usage to network 
storage applications.

Seamless integration: Serial ATA maintains register 
and software compatibility with Parallel ATA, and 
should be transparent to both the BIOS and oper-
ating system. Simply add more Serial ATA links to 
increase the number of connectivity points in your 
system.

•

The LaCie Biggest S2S will only function with the 
LaCie SATA II 3Gb/s PCI 4E Card or PCI-Express 
Card as the host controller, which provides port mul-
tiplier capability. The card will support other external 

devices. Please consult the User Manual for the LaCie 
SATA II 3Gb/s PCI 4E Card or PCI-Express Card in-
cluded with your Biggest S2S.

8.4. Host-support Port-multiplier Options
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Understanding RAID

Your LaCie Biggest S2S supports several different 
RAID levels: 0, 1, 0 + 1, and JBOD. This section will 
help you decide which RAID level is right for your ap-

plication. The storage policies of the LaCie Biggest S2S 
— Safe, Fast, Big and JBOD are combinations of these 
RAID levels.

9.1. RAID 0

Striped Disk Array Without Fault Tolerance

Also called striping, this level offers high transfer 
rates and is ideal for large blocks of data where speed 
is of the utmost importance. RAID 0 implements a 
striped disk array, where all of the hard disks are linked 
together to form one large aggregate hard disk. In this 
configuration, data is broken down into blocks and each 
block is written to a separate disk drive within the array; 
I/O performance is greatly improved by spreading the I/
O load across several drives. In this array, however, when 
one disk fails, all of the data on the array is lost. 

Storage capacity is determined by the smallest disk 
in the array, and the smallest disk’s capacity is applied to 
all of the other disks in the array. So, for instance, if you 
had four disks installed, ranging in capacity from 40GB 
to 80GB, when the RAID 0 array is built your system 
will see one, 160GB (40GB x 4) hard disk.

While this is a very simple and easily implemented 
design, RAID 0 should never be used in mission criti-
cal environments. When even just one disk in the array 
fails, all of the data on the entire array will be lost

Characteristics and Advantages

Data is broken down into blocks and each block 
is written to a separate disk drive

I/O performance improved by spreading the load 
across multiple drives

Overhead is lowered due to no calculations for 
parity

Simple design and easily implemented

•

•

•

•

This diagram represents a
RAID 0 array, consisting of
four disks, which are
connected to the Controller.
Data blocks are distributed
across all of the disks in the
array.

A
E
I
M

B
F
J
N

C
G
K
O

D
H
L

etc.

CONTROLLER

D
E

C
B
A

Recommended Uses

Video production and editing

Image editing

Pre-press applications

Applications requiring high-bandwidth

•

•

•

•
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9.2. RAID 1

Mirroring and Duplexing

Also called mirroring, this level makes a duplicate 
write on a second or “mirror” disk every time data is 
written to a primary disk. If one disk crashes, there is 
an ideal backup. 

Using two controllers, or duplexing, can speed the 
data I/O rate by writing to both drives at the same 
time. When using just a single controller operations are 
slowed because data is written first to the data drive and 
then to the mirrored drive. 

The storage capacity of a two-disk RAID 1 array is 
equal to the storage capacity of a single disk because the 
same data is duplicated on both disks. However, the 100 
percent redundancy of data does not require a rebuild 
in the case of a drive failure. In that case, data can be 
copied to a replacement disk.

Characteristics and Advantages

Can sustain multiple simultaneous drive failures 
in most cases

Simplest RAID storage subsystem design

Transfer rate for each block is the same as that of 
a single disk

Data is 100 percent redundant

•

•

•

•

A
B
C
D

A
B
C
D

E
F
G
H

E
F
G
H

CONTROLLER

D
E

C
B
A

This diagram represents a
RAID 1 array, consisting of
four disks, which are
connected to the Controller.
Data blocks are duplicated,
or mirrored in each pair of
disks in the array.

Recommended Uses

Payroll

Accounting

Financial 

Any use that requires high availability

•

•

•

•
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9.3. RAID 0+1

High Data Transfer Performance

This level combines striping and mirroring, which 
provides full data redundancy and protects data in the 
event that multiple drives fail (provided that the data on 
one of each mirrored pair of drives is intact). 

Storage capacity in this configuration is determined 
by multiplying the capacity of the smallest disk by two. 
If, for instance, there were four drives installed that 
ranged in capacity from 40GB to 70GB, as a RAID 0+1 
array, the total available capacity would be 80GB (40GB 
x 2). In this configuration, you must have an even num-
ber of disks, so in the case of the LaCie Biggest S2S, you 
would need to have four hard disks installed.

Characteristics and Advantages

Implemented as a mirrored array with RAID 0 
arrays as the segments

The same fault tolerance as RAID level 5

Fault-tolerance overhead is the same as that of 
mirroring

High I/O rates are achieved thanks to multiple 
striped segments

Excellent design for those seeking high perfor-
mance, without achieving maximum reliability

•

•

•

•

•

This diagram represents a
RAID 0 +1 array, consisting of
four disks, which are
connected to the Controller.
The Controller creates two
matching RAID 0 arrays on
the four disks.

A
E
I
M

B
F
J
N

C
G
K
O

D
H
L

etc.

CONTROLLER

D
E

C
B
A

R1 R1

Recommended Uses

Imaging Applications

General Fileserver

•

•
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9.4. JBOD

Just a Bunch of Disks

JBOD, or Just a Bunch of Disks, is not a numbered 
RAID level. However, it is similar because it is an Array 
of Inexpensive Disks. The process takes multiple drives 
and combines them into a single virtual drive without 
redundancy. The disks are strung together, end to end.

JBOD is similar to the opposite of partitioning. 
While partitioning creates two of more logical drives 

out of one physical drive, JBOD uses two or more physi-
cal drives to make one logical drive. 

Storage capacity of determined by adding the ca-
pacities of the individual physical drives. Thus a JBOD 
array could combine a 3 GB, 15 GB, and 5.5 GB, physi-
cal drives into a 23.5 GB logical drive. A JBOD array 
can be figured using hubs or a daisy chain.

CONTROLLER

A JBOD B

A JBOD B

A JBOD B

A JBOD B

A JBOD B

A JBOD B

A JBOD B

A JBOD B

A JBOD B

A JBOD B

CONTROLLER

HUB BHUB A

Daisy Chain Configuration Hub Based Configuration
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10. Troubleshooting

In the event that your LaCie Biggest S2S is not 
working correctly, please refer to the following checklist 
to find out where the problem is coming from. If you 
have gone through all of the points on the checklist and 
your drive is still not working correctly, please have a 
look at the FAQs that are regularly published on our 
Web site – www.lacie.com. One of these FAQs may 
provide an answer to your specific question. You can also 
visit the drivers pages, where the most recent software 
updates will be available.

If you need further assistance, please contact your 
LaCie reseller or LaCie Technical Support (see chapter 
11. Contacting Customer Service for details).

Technical note: Manual Updates
LaCie is constantly striving to give you the most 
up-to-date, comprehensive User’s Manuals avail-
able on the market. It is our goal to provide you 
with a friendly, easy-to-use format that will help 
you quickly install and utilize the many functions 
of your new device. 

If your manual does not reflect the configurations 
of the product that you purchased, please check our 
Web site for the most current version available.

10.1. LEDs and Fan

Problem Solution

Green “OK” LED does not light. Confirm the outlet to be powered, verify power connection, and try alternate power 
cable.

Red “!” LED is lit. Power cycle LaCie Biggest S2S update the LaCie Biggest S2S firmware.

LaCie Biggest S2S HOST 
LED1 is not lit.

Verify the OK LED status to confirm power, verify eSATA connection and try an 
alternate eSATA cable.

LED1 continuously flashes for 
one ormore disc drives.

LED1 will flash during a Safe volume rebuild. If the LED flashes while the LaCie 
Biggest S2S is not rebuilding, verify eSATA connection and try an alternate eSATA 
cable.

LED1 remains off for one or 
more disk drives.

Swap disk drives to ensure that this is not an LED problem. If the LED off state is 
specific to a disk drive, evaluate disk drive for failure.

Rear fan is not running or power 
supply fan is not spinning.

Confirm the outlet to be powered, verify power connection, and try alternate power 
cable.
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10.2. LaCie Biggest S2S connection to LaCie SATA PCI-X/PCI-Express Card

Problem Solution

Biggest S2S is not recognized by 
HBA BIOS.

Verify the OK LED status to confirm power.	
Verify the eSATA connection and try an alternate eSATA cable.
Verify recognition of  empty Biggest S2S by LaCie PCI-X/PCI-Express BIOS.
Turn off PCI-X/PCI-Express bus power save mode in the host BIOS.

Troubleshoot the HBA
Alternate SATA port.
Connect an alternate device to the HBA.
Remove all other PCI peripherals to rule out interference.
Move the HBA to an alternate PCI-X/PCI-Express slot.
Try the HBA in a PCI slot.

•
•
•
•

•
•
•
•
•

Operating system does not recog-
nize one or more of the Biggest 
S2S volumes.

Verify recognition of empty storage device by HBA BIOS.  Before deleting or 
altering storage device volumes with the Wizard, delete partitions residing on the 
volume. To delete partitions, first return the storage device to the previous configu-
ration.  Ensure the HBA driver is current. 

Troubleshoot  driver
Verify driver active status. For Windows, the Device Manager should show the 
SCSI icon       next to the HBA.
Resolve resource conflicts (IRQ, DMA, or I/O).
Identify maximum SATA disk drive capacity supported by the operating system 
and ensure the volume size meets the limits. 
Verify port multiplier support. See Host-multiplier support options for details.

•

•
•

•
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10.3. Review Event Log

Event logs are helpful for troubleshooting and locat-
ing a system malfunction.

To review an event log

Select Event log within the Edit menu in the Status 
window.

The Event Log screen displays a list of events in a 
tabular format. The Date column displays the date 
and time of the event, the Box SN and Drive SN 
columns display the respective serial numbers for the 
event and a Message column gives an event descrip-
tion.

Click Refresh to update the log or click Close to 
close the log.

1.

2.

3.
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11. Contacting Customer Support

Read the User Manual and review the Troubleshoot-
ing section.

Try to isolate the problem. If possible, make the 
drive the only external device on the CPU, and make 
sure that all of the cables are correctly and firmly at-
tached.

If you have asked yourself all of the pertinent ques-
tions in the troubleshooting checklist, and you still can’t 
get your LaCie drive to work properly, contact us via 
the contacts on page 34. Before contacting us, make sure 
that you are in front of your computer and that you have 
the following information on hand:	

1.

2.

Your LaCie drive’s serial number

Operating system and version

Computer brand and model

Amount of memory installed

Names of any other devices installed on your com-
puter, including CD/DVD burners

•

•

•

•

•

11.1. Before You Contact Technical Support
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Contacting Customer Support

LaCie Asia, Singapore, and Hong Kong 
Contact us at: 
http://www.lacie.com/asia/contact/

LaCie Australia 
Contact us at: 
http://www.lacie.com/au/contact/

LaCie Belgium 
Contact us at: 
http://www.lacie.com/be/contact/ (Français)

LaCie Canada 
Contact us at: 
http://www.lacie.com/caen/contact/ (English)

LaCie Denmark 
Contact us at: 
http://www.lacie.com/dk/contact

LaCie Finland 
Contact us at: 
http://www.lacie.com/fi/contact/

LaCie France 
Contact us at: 
http://www.lacie.com/fr/contact/

LaCie Germany 
Contact us at: 
http://www.lacie.com/de/contact/

LaCie Italy 
Contact us at: 
http://www.lacie.com/it/contact/

LaCie Japan 
Contact us at: 
http://www.lacie.com/jp/contact/

LaCie Netherlands 
Contact us at: 
http://www.lacie.com/nl/contact/

LaCie Norway 
Contact us at: 
http://www.lacie.com/no/contact/

LaCie Spain 
Contact us at: 
http://www.lacie.com/es/contact/

LaCie Sweden 
Contact us at: 
http://www.lacie.com/se/contact

LaCie Switzerland 
Contact us at: 
http://www.lacie.com/chfr/contact/ (Français)

LaCie United Kingdom 
Contact us at: 
http://www.lacie.com/uk/support/request/

LaCie Ireland 
Contact us at: 
http://www.lacie.com/ie/contact/

LaCie USA 
Contact us at: 
http://www.lacie.com/contact/

LaCie International 
Contact us at: 
http://www.lacie.com/intl/contact/
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12. Warranty

LaCie warrants your LaCie Biggest S2S and Drive 
Bays against any defect in material and workmanship, 
under normal use, for the period designated on your 
warranty certificate. In the event this product is found 
to be defective within the warranty period, LaCie will, 
at its option, repair or replace the defective LaCie Big-
gest S2S and/or Drive Bay(s).

This warranty is void if:

The LaCie Biggest S2S was operated/stored in ab-
normal use or maintenance conditions;

The LaCie Biggest S2S is repaired, modified or al-
tered, unless such repair, modification or alteration is 
expressly authorized in writing by LaCie;

The LaCie Biggest S2S was subjected to abuse, ne-
glect, lightning strike, electrical fault, improper pack-
aging or accident;

The LaCie Biggest S2S was installed improperly;

The serial number of the LaCie Biggest S2S or an 
individual Drive Bay is defaced or missing;

The broken part is a replacement part such as a pick-
up tray, etc.

The tamper seal on the LaCie Biggest S2S or an in-
dividual Drive Bay casing is broken.

A hard disk from one of the Drive Bays was removed 
or replaced by someone other than a LaCie techni-

•

•

•

•

•

•

•

•

cian or a repair technician authorized by LaCie. 

LaCie and its suppliers accept no liability for any 
loss of data during the use of this device, or for any of 
the problems caused as a result. 

LaCie will not, under any circumstances, be liable 
for direct, special or consequential damages such as, but 
not limited to, damage or loss of property or equipment, 
loss of profits or revenues, cost of replacement goods, 
or expense or inconvenience caused by service interrup-
tions.

Any loss, corruption or destruction of data while us-
ing a LaCie drive is the sole responsibility of the user, 
and under no circumstances will LaCie be held liable for 
the recovery or restoration of this data.

Under no circumstances will any person be entitled 
to any sum greater than the purchase price paid for the 
drive.

To obtain warranty service, call LaCie Techni-
cal Support. You will be asked to provide your LaCie 
product’s serial number, and you may be asked to furnish 
proof of purchase to confirm that the drive is still under 
warranty.

All drives returned to LaCie must be securely pack-
aged in their original box and shipped with postage pre-
paid.

Important Info: Register online for free 
technical support:  www.lacie.com/register


	Forward
	Health and Safety Precautions
	General Use Precautions

	1. Introduction
	1.1. LaCie Biggest S2S Capabilities

	2. Your Biggest S2S
	2.1. Minimum System Requirements
	2.2. Package Content
	2.3. Views of the Drive
	2.3.1. Front View
	2.3.2. Rear View

	2.4. Cables and Connectors
	2.4.1. Serial ATA II and eSATA


	3. Setting Up Your LaCie Biggest S2S
	3.1. Storage Policies
	3.2. Installation Prerequisites
	3.3. Installing the PCI-X/PCI-Express Card and Drive
	3.4. Set Up the Biggest S2S
	3.5. Set Up the Biggest S2S Disk Drives
	3.5.1. Windows Users
	3.5.2. Mac Users

	3.6. Install the LaCie Biggest S2S Manager
	3.6.1. Windows Users
	3.6.2. Mac Users


	4. Using your LaCie Biggest S2S
	4.1. To run the LaCie Biggest S2S Manager 
	4.1.1. Windows
	4.1.2. Mac OS X
	4.1.3. Biggest S2S Manager Launch Sequence (Mac OS X)

	4.2. Customize Password
	4.3. A look at the LaCie Biggest S2S Status Window
	4.4. A look at the LaCie Biggest S2S Configuration Mode
	4.4.1. Basic Configuration Mode
	4.4.1.1. Configure JBOD (Bypass)
	4.4.1.2. Configure Safe
	4.4.1.3. Configure Fast
	4.4.1.4. Configure Big
	4.4.1.5. Configure Safe + Big
	4.4.1.6. Configure Safe + Fast

	4.4.2. Advanced Configuration Mode
	4.4.2.1. A Look at the Advanced Configuration Mode
	4.4.2.2. Advanced Configuration Mode Sections
	4.4.2.2.1. Toolbar buttons
	4.4.2.2.2. Command buttons

	4.4.2.3. Configuring Multiple Volumes
	4.4.2.4. Managing Configuration Files
	4.4.2.4.1. Importing a Configuration File
	4.4.2.4.2. Saving a Configuration File


	4.4.3. Partition Configured Volume
	4.4.3.1. Windows Users
	4.4.3.2. Partition configured volume — Mac OS X

	4.4.4. Manage Configuration Files
	4.4.4.1. To Import a File
	4.4.4.2. To Export a File

	4.4.5. Manage Client Connection to the Daemon
	4.4.6. Email Notification
	4.4.6.1. Setting Up Email Notification
	4.4.6.2. Receiving an Email Notification



	5. Maintaining Your Biggest S2S
	5.1. Removing/Replacing a Drive
	5.2. Install New Firmware (Upgrade)
	5.3. Configure Safe Volume Rebuild Storage Policy

	6. Monitor the LaCie Biggest S2S Storage Appliance
	6.1. To Monitor Drive Status
	6.2. To Monitor Temperature

	7. LaCie Biggest S2S Front Panel LED Indicators
	8. Tech Tips
	8.1. Available Storage Capacity
	8.2. File System Formats
	8.2.1. Mac Users
	8.2.2. Windows Users

	8.3. Serial ATA II Questions and Answers
	8.4. Host-support Port-multiplier Options

	9. Understanding RAID and Biggest S2S Storage Policies
	9.1. RAID 0
	9.2. RAID 1
	9.3. RAID 0+1
	9.4. JBOD

	10. Troubleshooting
	10.1. LEDs and Fan
	10.2. LaCie Biggest S2S connection to LaCie SATA PCI-X/PCI-Express Card
	10.3. Review Event Log

	11. Contacting Customer Support
	11.1. Before You Contact Technical Support
	11.2. LaCie Technical Support Contacts

	12. Warranty

